
DVR 518 
 Digital Video Camcorder 
User’s Manual 
 

 
  
 
 
 
 
                                               
 

 
© 2009 Sakar International, Inc. All rights reserved. 
Windows and the Windows logo are registered trademarks of Microsoft Corporation. 
All other trademarks are the property of their respective companies. 



 

  1 

Table of Contents 
 
Introduction ...................................................................................................2 
Key Features ................................................................................................2 
What your digital video camcorder includes ..................................................3 
Computer System Requirements for Windows XP........................................4 
Computer System Requirement for Windows Vista ......................................5 
Computer System Requirements for Macintosh ...........................................5 
A Quick Look at your Digital Video Camcorder .............................................7 
Preparing Your Camcorder for Use...............................................................8 
Inserting an SD Memory Card ......................................................................9 
Maintenance and Care ................................................................................ 11 
DVR Function Control ................................................................................. 12 
Capturing Videos ........................................................................................ 15 
Taking Photos ............................................................................................. 21 
Audio Mode ................................................................................................. 34 
Playback mode ........................................................................................... 35 
Setup Mode ................................................................................................ 50 
Connecting the Camcorder to a TV............................................................. 59 
Install the Vivitar Experience Image Manager Software .............................. 59 
Connect your camcorder to the computer ................................................... 63 
Get photos and videos from your camcorder to your computer .................. 63 
Get started! ................................................................................................. 65 



 

  2 

Transfer media from my camcorder to my computer manually (Using 
Windows) .................................................................................................... 66 
Transfer media from my camcorder to my computer manually (Using 
Macintosh) .................................................................................................. 67 
Using your camcorder as a PC Camera (on Windows) ............................... 68 
Sakar Warranty Card .................................................................................. 69 
Technical Specifications ............................................................................. 70 
Trouble Shooting......................................................................................... 72 

Introduction                                                                                                               
Thank you for purchasing the DVR 518 Digital Video Camcorder. With your 

camcorder you can shoot video clips, take individual photos and record audio 

files. In addition, a SD compatible memory card of up to 8GB can be inserted in 

order to expand the memory of your DVR camcorder. 

Your camcorder also has a PC Camera function for web conferencing.  

Key Features  
 5 modes – Video, Audio, Camera, Playback and Set Up. 

 Digital Video resolutions – 640x480 (VGA), 320x240 (QVGA). 
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 5 digital camera resolutions - 8M(3264X2448); 5M(2592X1944); 

3M(2048X1536); 1M(1024X768); VGA(640X480)  

 1.96"  TFT LCD 

 8 X Digital Zoom 

 Limited Internal Memory 

 Supports external SD memory card up to 8GB 

 Built-in Microphone 

 Takes digital photos, videos and  record audio files 

 Delete, rotate, protect, crop and print photos directly on and from your 

camcorder  

 Vivitar Experience Image Manager software for uploading and managing 

photos and videos to or from the most popular photo sharing and social 

network websites. 

What your digital video camcorder includes 

 Digital Video Camcorder  

 USB cable 
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 TV-out cable 

 Vivitar Experience Image Manager software Installation CD 

 Quick Start Guide 

 Pouch 

 Hand strap 

 

 

 

Computer System Requirements for Windows XP 
To be able to download photos and videos to your PC, you will need the following 
minimum configuration: 

 Pentium 4 processor or above with Windows XP service pack 2 

 512 MB RAM, with 100MB of free disk space 

 1024 x 768 Recommended screen resolution  

 16-bit color or higher display adaptor 

 CD-ROM Drive 

 QuickTime 6 or higher  

 Microsoft Internet Explorer 7 or higher 

 Windows Media Player 10 or higher 
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 Internet connection required 

 

Computer System Requirement for Windows Vista 
To be able to download photos and videos to your PC your will need the following 
minimum configuration: 

 Windows Vista 

 800MHz processor and 512 MB of system memory 

 20GB hard drive with at least 15GB of available space 

 Support for Super VGA graphics 

 Available USB Interface  

 CD-ROM drive 

 QuickTime 6 or higher  

 Microsoft Internet Explorer 7 or higher 

 Internet connection required 

 

Computer System Requirements for Macintosh 
 

 Macintosh with Intel processor running Mac OS X v10.4.6 or later 
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 256 MB RAM, 100 MB free disk space 

 Display: 1024 x 768 or higher-resolution monitor 

 QuickTime 6 or higher 

 Internet connection required   
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A Quick Look at your Digital Video Camcorder  

 

 

 

 

 

 

 

 

 

 

1 Display button 

2 LED On / Off 

button 3 Mode button  

4 Shutter button 

5 Up button  

6 OK button 

7 AV / USB jack   

8 Right/Self-timer 

button  9 MENU button 

10 Down button  

11 Power button 

12 Left button  

13 LCD screen 

14 Tripod socket 

15 SD card slot 

16 Wrist strap 

17 Battery cover 

18 Lens 
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Preparing Your Camcorder for Use 
Battery Installation 

 Your DVR camcorder requires 3 “AAA” batteries (not included). It is recommended that 

alkaline batteries be used.  

 

1. Lift and open the battery compartment on the side of the camcorder. 

 

 

 

 

 

 

 

2.  Insert the batteries in accordance with the polarity indicated in the battery 

compartment. 

3. Return and close the battery cover. 

     

Note: 
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 Limited internal memory is provided in order to take photos, videos and audio. 

 A SD Memory card is required to expand the memory in order to capture and 

record many more media items. All the media in the built-in memory will not be lost if 

no SD Memory Card has been inserted in the DVR or when you change your 

batteries. 

 We strongly recommend downloading your photos and videos regularly to your 

computer.  

 Remove the batteries from the DVR camcorder when not in use for an extended 

period. 

 

 

Inserting an SD Memory Card 
An SD compatible memory card of up to 8GB (not included) should be inserted into 

your DVR camcorder. SD Memory cards expand the amount of memory thus allowing 

an increase in the number of movies, photos and audio that can be captured before 

transferring them to a computer.  

Media sitting on the memory card is not lost when your camcorder’s power runs low or 

on replacing the batteries.     



 

  10 

                                            

1.     Locate the SD card slot on the bottom of the camcorder. 

2.     Insert an SD memory card correctly in the direction shown. 

3.    Press the memory card until you hear a “Click” sound. The memory card when 

properly inserted will sit flush with the camcorder. 

 

Note: After you insert an SD memory card, the SD card icon will appear on the right 

side of the LCD, indicating that your SD memory card has been installed successfully. 

The media you capture will now be stored on the card and not in the internal memory. 

 

 This product supports SD cards of up to 8GB. 
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 Formatting will delete all data on the SD Memory Card including protected data. 

 Do not remove the SD memory Card during formatting as this may damage the 

card and render it unusable. 

 Before using the camcorder, be sure to format the card with the camcorder (see 

the Setup section further on in the manual for instruction on how to format the card). 

 

Maintenance and Care 
Before using the video camcorder, please ensure that you read and understand the 
safety precautions described below: 
  

• Do not try to open the case of the video camcorder or attempt to modify this video 

camcorder in any way. Maintenance and repairs should be carried out only by 

authorized service providers. 

• Keep the video camcorder away from water and other liquids. Do not use the video 

camcorder with wet hands. Never use the video camcorder in the rain or snow. 

Moisture creates the danger of electric shock. 

• Use only the recommended power accessories. Use of power sources not expressly 

recommended for this equipment may lead to overheating, distortion of the 

equipment, fire, electrical shock or other hazards.  
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DVR Function Control 

To power on the camcorder you need to flip open the LCD Screen. The 

Power button is situated on the inside of the camcorder. 

 

Power on 

Press the Power button to turn on your DVR.  

The LCD monitor will light up indicating that your DVR is ready for use. 

  

Power off  

Press the Power button to turn your DVR camcorder off. The DVR camcorder will 

switch off.  

If the DVR camcorder is not in use or in an operation mode for 60 seconds it will 

switch off automatically.  

When there is insufficient battery power, a “Low Battery” message will appear on the 

LCD screen. The camcorder will automatically power off a few moments later. 
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Setting the Language 

When using the video camcorder for the first time after purchasing it, be sure to 
choose a language and set the date & time before using the video camcorder. 
 
1. Turn the Power on. 
2. Press the MENU button. 
3. Press the Right button on the OK dial to open the Setup menu. 
4. Press the Up/Down button on the OK dial and select the Language option. 
5. Press the Right button to enter the Language submenu. 
6. Press the Up/Down button to highlight and select the language you desire. 
7. Press the OK button to save your choice and for the language interface of the 

camcorder to change to the language you selected.  
8. Press the MENU button to close the menu and exit the Setup function. 

 
 

   Setting the Date and Time 
     This will be the time and date that will appear on the photos you capture. 
 

1. Turn the Power on. 

2. Press the MENU button. 

3. Press the Right button on the OK dial to open 
the Setup menu. 

4. Press the Up/Down button on the OK dial and 
select the Date & Time option. 
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5. Press the OK button to open the date and time settings. 

6. Press the Left/Right button to select the Year, Month, Day, Hour, Minute and 
Date Format (YYYY/MM/DD , DD/MM/YYYY , MM/DD/YYYY) options. 

7. Press the Up/Down button to change the digits on each of the settings you 
wish to update. 

8. Press the OK button to save your choice.  

9. Press the MENU button to close the menu and exit the Setup function 
 

    Change the camcorder`s mode 
There are four modes in this DVR camcorder. 

 
1. Press the POWER button to turn on the camcorder. 
2. The video default capture mode appears on the LCD. 
3. Press the DV/DSC mode button to the bottom left of the LCD screen to change 

the mode.  
4.  Each time the DV/DSC mode button is pressed the mode icon is changed. 

 
 
 
 
 

Display Title Description 

 
Capture mode For taking still photos. 

 
Video mode For recording movie clips. 

 
Audio mode For recording audio files. 

 
Playback mode  Preview the record files. 
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Capturing Videos 

In order to capture videos (with audio) using your camcorder you need to select 

the Video mode. On turning on your camcorder the first mode to appear is the 

Video mode. To change between the function modes on your DVR, press the 

DV/DSC button on the bottom left of the LCD screen.  

Use a compatible SD card of up to 8 GB to expand the memory capacity to 

capture even more and longer videos than can be captured using internal 

memory only. 

 

The video  icon will now appear on the top left corner of the LCD. 

 

1. The amount of time left at that resolution and memory appears on the top 

right of the LCD.  

2. Aim the camcorder at the subject or object you wish to capture. 

3. Press the Shutter button on the top of the camcorder to start shooting.  

4. The elapsed time of the video will appear on the top right on the LCD. 
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5. Press the Right button if you wish to Pause the recording in the middle and 

again to resume recording. 

6. Press the Shutter button again to stop the recording. 

7. The recorded file will be saved in AVI format. 

 

Note:  

1. Press the Up button to Zoom In or the Down button to Zoom Out of the 
subject during the shooting to focus in on your subject. 

2. You can view the AVI files in playback mode. 
3. Once they are downloaded to the PC view them using QuickTime and 

Windows Media Player. 
4. As the internal memory of the camcorder is limited it should be used for 

test files only. 
5. Please insert an SD memory card of up to 8 GB to capture longer videos. 
6. When the internal memory is full, a “Memory Full” message will flash on 

the LCD screen when you attempt to shoot further videos. 
 

      Video Setting options 

In Video mode there are two video resolutions for you to choose from (VGA – 

640x480, QVGA – 320x240 pixels) before capturing your video. The higher the 

resolution selected the better the quality of the video, however higher quality 
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videos use up more memory. You can also change the Frame Rate, Metering 

and White Balance.  

 

 

 

 

 

 

 

 

 

 

 

To enter the Settings options for the Video mode: 

1. Press the MENU button. 

2. Press the Up/Down button to select the Setting you wish to change from 

the menu that appears.  
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Movie Size 

You can select different Video resolutions - VGA 640x480 pixels / QVGA 
320x240 pixels  
 

1. Press the Up/Down button to select the Movie Size menu. 
2. Press the OK button to open the Movie Size submenu. 
3. Press the Up/Down button to highlight and select the resolution option: 

                    VGA 640x480, QVGA 320x240 
 

4. Press the OK button to confirm, save your choice and exit to the Setting 
menu. 

5. Press the MENU button to revert back to the Video capture mode to start 
capturing videos with the new resolution selected. 
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Note: 
After selecting your resolution, the corresponding icon will appear on the top of 
the LCD.  
 

   Frame Rate 
              This setting allows you to control the frame rate for video capture. 
 

1. Press the Up/Down button to select the Frame Rate menu. 
2. Press the OK button to open the Frame Rate submenu. 
3. Press the Up/Down button to highlight and select the rate option: 

30fps High, 15fps Low 
 

4. Press the OK button to confirm, save your choice and exit to the Setting 
menu. 

5. Press the MENU button to revert back to the Video capture mode to start 
capturing videos with the new frame rate selected. 

 

   Metering 
              This setting allows you to change the brightness of the video. 
 

1. Press the Up/Down button to select the Metering menu. 
2. Press the OK button to open the Metering submenu. 
3. Press the Up/Down button to highlight and select the metering option: 
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[Center]: The exposure will be calculated based on light in the center area 
and this is suitable for general use. 
[Multi]: The exposure will be calculated based on the average light. 
[Spot]: Only the spot in the center of the LCD screen will be metered for 
light. 
 

4. Press the OK button to confirm, save your choice and exit to the Setting 
menu. 

5. Press the MENU button to revert back to the Video capture mode to start 
capturing videos with the metering selected. 

 
Note: 
After selecting your metering choice, the corresponding icon will appear on the 
top of the LCD.  

 
  White Balance 
         This setting is used to adjust the color of your videos as per your light source. 
 

1. Press the Up/Down button to select the White Balance menu. 
2. Press the OK button to open the White Balance submenu. 
3. Press the Up/Down button to highlight and select the White Balance option: 

Auto / Daylight / Cloudy / Fluorescent / Incandescent. 
 

4. The White Balance choice selected automatically appears on the LCD. 
5. Press the OK button to confirm, save your choice and exit to the Setting 
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menu. 
6. Press the MENU button to revert back to the Video capture mode to start 

capturing videos with the new white balance selected. 
 
Note: 
After selecting your White Balance choice, the corresponding icon will appear 
on the top of the LCD.    
 

Taking Photos  

After you power on your camcorder, press the DV/DSC mode button on the bottom 
left of the LCD screen. 

The camera  icon appears in the top left corner of the screen. 
The camcorder`s internal memory is limited per each resolution so it is 
recommended to insert a compatible SD card of up to 8GB in order to expand the 
memory and capture many more memorable photos. 
 

   Use the image that appears in the LCD to compose your shot. 

1. Hold the camcorder steady and press the Shutter button on the top of the 

camcorder.  

2. The camcorder will beep and the picture taken as jpeg and saved to the 
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memory.  

3. The number of photos that can be taken for each resolution and per the 
memory card inserted appears on the top right of the LCD screen. 
 

4. After the shot is taken the number is reduced by one.  

5. When the camcorder's internal memory is full, “Memory Full” will appear on 
the LCD screen when you attempt to press the Shutter button to take a photo. 
Either download the photos to your computer using the Vivitar Experience 
Image Manager software as described below in the section “Transfer photos 
and videos to your computer” or insert an SD card to continue taking more 
photos and videos. 
 

6. The number of photos that can be captured not only depends on the internal 

memory or the SD card’s capacity but also on the resolution selected. Better 

quality photos are taken at higher resolutions but these will also take up more 

memory on the card. 

 
     
   LED Lamp 
 

When light conditions are poor, press the LED ON/OFF button on the middle left of 
the LCD Screen. 
Two LED white lamp lights will light up (like a torch) to offer better lighting. 
To turn off the LED light, press the LED ON/OFF button again.  
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   Digital Zoom function 
     You can magnify your subject up to 8 times using the digital zoom.  

 
1. Press the Up button to Zoom In to the object. 
2. Press the Down button to Zoom back out.  
3. The digital zoom digit icon appears on the bottom right corner of the LCD 

screen.  
 
   Self-Timer 
     You can include yourself in a photo by using this feature to delay the time between 

your pressing of the shutter button and when the photo is actually taken. Place the 
camcorder on a tripod or on a flat and sturdy surface before pressing the Shutter 
button. 

 
       There are 2 methods to activate the Self-Timer. 
 
         Method 1: 

1. In the camera mode, press the Right button. 
2. The Self-Timer icon on the top of the LCD will appear. 
3. Press the Right button until you see the Self-Timer option you wish to 

use appear: 
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   2 Seconds, 10 Seconds, Burst (continuous 
snapshot) 

 
4. Press the Shutter button. 
5. The digit time countdown appears on the LCD and the red LED next to 

the lens flashes for every second of the countdown. 
6. After the selected time delay the photo will be taken. 

 
         Method 2: 

1. In the camera mode, press the MENU button. 
2. Press the Up/Down button to select the Driver Mode menu option. 
3. Press the OK button to enter the Driver Mode submenu. 
4. Press the Up/Down button to highlight and select the Driver Mode 

option: 

Self-timer 2S, 

 Self-timer 10S,  

Burst (continuous snapshot) 

 
 

5. Press the OK button to save your choice. 
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6. Press the MENU button to exit the Setting menu and revert to the 
Camera mode. 

7. The Self-Timer icon appears on the top of the LCD screen. 
8. Press the Shutter button. 
9. The digit time countdown appears on the LCD and the red LED next to 

the lens flashes for every second of the countdown. 
10. After the selected time delay the photo will be taken. 

 

 
   Burst 

              Take 3 consecutive photos automatically. You will need enough memory in 
the camcorder to use this option. 

 The Burst option is found together with the Self-timer options in the Driver 
Mode submenu. 

 Using methods 1 or 2 as explained above, select the Burst icon. 
 
 

1. The Burst icon will appear next to the Camera icon on the top left 
corner of the LCD. 

2. Press the Shutter button. 
3. The camcorder will now automatically take 3 continuous photos with 

intervals of 1 second between shots. 
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Capture Setting options 
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 The camera setting allows you to manage the way you wish to take photos. You can 
select and change the Resolution pixel size, Quality, Metering, White Balance, 
Exposure, Driver Mode, Effect and Date Stamp of the photos. 

 
To enter the Settings options for the Capture mode: 

1. Press the MENU button. 

2. Press the Up/Down button to select the Setting you wish to change from 

the menu that appears.  

 
 
 
 
 
 
 
 
 
 
 Resolution 

The image size and quality settings determine the number of photos that can 
be saved and the amount of memory required for each photo. The higher the 
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quality of the photo the more memory it will take. The image size and quality 
will also affect the maximum size you can print your photo effectively.  
 
To set the camcorder`s resolution: 
 

1. Press the Up/Down button to select the Resolution menu. 
2. Press the OK button to open the Resolution submenu. 
3. Press the Up/Down button to highlight and select one of the resolution 

options: 
 

  8M(3264X2448); 5M(2592X1944); 3M(2048X1536); 1M(1024X768); 

VGA(640X480)  

 
4. Press the OK button to confirm, save your choice and exit to the Setting 

menu. 
5. Press the MENU button to revert back to the Camera capture mode to start 

taking photos with the resolution selected. 
 
Note: 
After selecting your resolution, the corresponding icon will appear on the top of 
the LCD.  

 
 

Quality 
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The quality of your photos also affects the number of shots you can take. The Super 
setting means you can take fewer photos, but they will be better quality. 

 
1. Press the Up/Down button to select the Quality menu. 
2. Press the OK button to open the Quality submenu. 
3. Press the Up/Down button to highlight and select one of the quality options: 

 
Super / Fine / Normal. 
 

4. Press the OK button to confirm, save your choice and exit to the Setting 
menu. 

5. Press the MENU button to revert back to the Camera capture mode to start 
taking photos with the resolution selected. 

 
Note: 
After selecting your resolution, the corresponding icon will appear on the top of 
the LCD.  

            Super quality      Fine quality      Normal quality           

 
Metering 
              This setting allows you to change the brightness of the photo. 
 

1. Press the Up/Down button to select the Metering menu. 
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2. Press the OK button to open the Metering submenu. 
3. Press the Up/Down button to highlight and select the metering option: 

 
[Center]: The exposure will be calculated based on light in the center area 
and this is suitable for general use. 
[Multi]: The exposure will be calculated based on the average light. 
[Spot]: Only the spot in the center of the LCD screen will be metered for 
light. 
 

4. Press the OK button to confirm, save your choice and exit to the Setting 
menu. 

5. Press the MENU button to revert back to the Camera capture mode to start 
taking photos with the metering selected. 

 
Note: 
After selecting your metering choice, the corresponding icon will appear on the 
top of the LCD.  

 
  White Balance 
         This setting is used to adjust the color of your photos as per your light source. 
 

1. Press the Up/Down button to select the White Balance menu. 
2. Press the OK button to open the White Balance submenu. 
3. Press the Up/Down button to highlight and select the White Balance option: 
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Auto / Daylight / Cloudy / Fluorescent / Incandescent. 
 

4. The White Balance choice selected automatically appears on the LCD. 
5. Press the OK button to confirm, save your choice and exit to the Setting 

menu. 
6. Press the MENU button to revert back to the Camera capture mode to start 

taking photos with the new white balance selected. 
 
Note: 
After selecting your White Balance choice, the corresponding icon will appear 
on the top of the LCD.    

 
    Exposure 

             This setting allows you to manually compensate for unusual lighting conditions 
such as indirect indoor lighting, dark backgrounds, and strong backlighting. The 
exposure value range is –2.0 (Dark) to 2.0 (Bright) in increments of 0.3. 

  
1. Press the Up/Down button to select the Exposure menu. 
2. Press the OK button to open the Exposure submenu. 
3. Press the Left/Right buttons to select the exposure setting as per the present 

light condition: 
 
EV-2.0 / EV-1.7 / EV-1.3 / EV-1.0 / EV-0.7 / EV-0.3 / EV+0.0 / EV+0.3 / 
EV+0.7/ EV+1.0 / EV+1.3 / EV+1.7/ EV+2.0 
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4. The Exposure choice selected automatically appears on the LCD. 
5. Press the OK button to confirm, save your choice and exit to the Setting 

menu. 
6. Press the MENU button to revert back to the Camera capture mode to start 

taking photos with the new exposure setting selected. 
 
Note: 
After selecting your Exposure choice, the corresponding icon will appear on the 
top of the LCD.    

 
Driver Mode 
   Use this mode to activate the Self-timer or the Burst continuous shot function 

 
1. Press the Up/Down button to select the Driver Mode menu option. 
2. Press the OK button to enter the Driver Mode submenu. 
3. Press the Up/Down button to highlight and select the Driver Mode 

options: 

Self-timer 2S, Self-timer 10S, Burst (continuous 
snapshot) 

 
 

4. Press the OK button to save your choice. 
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5. Press the MENU button to exit the Setting menu and revert to the 
Camera mode. 

6. The Self-Timer or Burst icon appears on the top of the LCD screen. 
7. Press the Shutter button. 
8. If you selected the self-timer, the digit time countdown appears on the 

LCD and the red LED next to the lens flashes for every second of the 
countdown before the photo is taken. 

9. If you selected the Burst option, on pressing the Shutter button 3 photos 
will be taken automatically with 1 second intervals.  

 
Effect 
         This setting is used to change the image’s color tone. 
 

1. Press the Up/Down button to select the Effect menu. 
2. Press the OK button to open the Effect submenu. 
3. Press the Up/Down button to highlight and select the Effect option: 

 
Normal / B&W / Sepia / Negative / Red 
 

4. The Effect choice selected automatically appears on the LCD. 
5. Press the OK button to confirm, save your choice and exit to the Setting 

menu. 
6. Press the MENU button to revert back to the Camera capture mode to start 

taking photos with the new effect selected. 
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Date Stamp 
With this function, you may record the date and time on your photo. 
 

1. Press the Up/Down button to select the Date Stamp menu. 
2. Press the OK button to open the Date Stamp submenu. 
3. Press the Up/Down button to highlight and select the Date Stamp option: 

 
                 [Off]: Neither date nor time is added to the image.  
                   [Date]: Add date only to the image.  
                  [Date& Time]: Add date and time to the image. 
 

4. Press the OK button to confirm, save your choice and exit to the Setting 
menu. 

5. Press the MENU button to revert back to the Camera capture mode to start 
taking photos with the date stamp appearing on the photo when it is taken 
and when viewing the photos in Playback mode. 

 
 

 
 

Audio Mode 

You can record audio clips with your camcorder. The amount of time to record 

your audio clips depends on how much memory is left after capturing videos 
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and taking photos. Insert an SD card to expand the memory capacity of the 

camcorder to enjoy many more hours of recording. 

After you power on your camcorder, press the DV/DSC mode button on the bottom 
left of the LCD screen until the Audio screen appears. 

The Audio screen will appear with the audio  icon appearing on the top left 
corner of the screen. 
 
The amount of time that you have to record audio files appears on the top right 
corner of the LCD. 
 
1. Press the Shutter button to being recording. 
2. The lapsed time for the audio clip appears in the center of the LCD. 
3. Press the Up button to pause the recording. 
4. Press the Up button again to resume recording.  
5. Press the Shutter button to stop and save the recorded audio file in WAV 

format to memory. 
 

 

Playback mode 

You can playback the videos, photos and audio files in your camcorder or 
attach the TV-out cable to watch them on your TV screen.  
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After you power on your camcorder, press the DV/DSC mode button on the bottom 
left of the LCD screen until the Playback screen appears. 

The Playback screen will appear with the Playback  icon appearing on the top 
left corner of the screen. 
Press the Left/Right buttons to select the image you wish to view. 
 
   A Photo file appears with the Playback icon only. 

   A Video file appears with an additional Video icon on the bottom left corner 
of the LCD 

   An Audio file also appears with an Audio icon on the bottom left corner of the 
LCD. 

 

 In Playback mode you can Lock, Delete, View as Slideshows, 
change the Effect, Rotate, Resize, add a Voice Memo or save the 
photo as the Start-up Image. 

 You can Lock and Delete the video clips recorded.  
 You can Lock and Delete the audio files recorded. 

 
Note:  
If there are no images in your memory the “No Image” message will appear 
on the LCD screen. 
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Thumbnail display 
 
When the camcorder is in the Playback Mode 
1. Press the Down button for all the images to appear as thumbnails.  
2. Press the OK button for the image to appear in full screen.  
3. If you selected a JPG file then once in full screen display mode, you 

can press the Up button to Zoom in and out of the photo 
4. Press the Up/Down/Left/Right buttons to scroll around the enlarged 

photo. 
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Note: You can know from the thumbnail what the image is - JPEG files do 
not have any icons on the thumbnail screen. AVI`s will have a V appear on 
the thumbnail and WAV files will have the audio icon. 

 
Operation for still photos 

             Select a still photo (an icon  will appear on the top left corner of the LCD). 
 

Press the Up and then the Up/Down buttons to Zoom in or Out of the photo. 
Press the Left/Right/Up/Down buttons to navigate around your photo 
Press the OK button to exit the Zoom mode and revert back to the original 
photo 

 

 You now have the option to edit these photos -  Lock, Delete, View 
as Slideshows, change the Effect, Rotate, Resize, add a Voice 
Memo or save the photo as the Start-up Image. 

            Lock 
You can lock and protect your photos, videos or audio files from 
accidental deletion.  
 

1. Press the MENU button. 
2. Press the Up/Down button to select the Lock menu. 
3. Press the OK button to open the Lock submenu. 
4. Press the Up/Down button to highlight and select one of the lock 

options: 
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                Lock/Unlock One; Lock All; Unlock All  

5.   If you selected Lock/Unlock One and press the OK button a “Protect 
Image?” or “Unprotect Image” confirmation message will appear with 
“Yes” and “No” options. 

6.  Press the Up/Down button to select Yes to lock/unlock or No to exit. 
7.  Press the OK button to confirm, save and protect/unprotect the 

selected image. 
 

8.  If you selected Lock All and press the OK button a “Protect All?” 
confirmation message will appear with “Yes” and “No” options. 

9.  Press the Up/Down button to select Yes to lock or No to exit. 
10.  Press the OK button to confirm, save and protect all the images. 

 
11.  If you selected Unlock All and press the OK button an “Unprotect All?” 

confirmation message will appear with “Yes” and “No” options. 
12.  Press the Up/Down button to select Yes to unlock or No to exit. 
13.  Press the OK button to confirm, save and unprotect all the previously 

protected images. 
 

Note: 

After selecting your lock preference, the corresponding lock  icon will 
appear on the left hand side of the LCD for the image(s) selected.  

            
                     



 

  40 

             Delete 
You can delete unwanted photos, videos and audio files at any time 
to free up memory. You can delete one at a time or delete all the 
unprotected files that are currently recorded on the memory card at 
once. 
 

1. Press the MENU button. 
2. Press the Up/Down button to select the Delete menu. 
3. Press the OK button to open the Delete submenu. 
4. Press the Up/Down button to highlight and select one of the delete 

options: 
 

                One; All  

5.  If you selected One and press the OK button a “Delete This File?” 
confirmation message will appear with “Yes” and “No” options. 

6.  Press the Up/Down button to select Yes to delete or No to exit. 
7.  If Yes, press the OK button to confirm, save and delete the selected 

image. 
8.  If the selected file is locked a “File locked!” message will appear. To 

unlock the file follow Steps 1 to 6 in the Lock section above.  
 

9.  If you selected All and press the OK button a “Delete All?” confirmation 
message will appear with “Yes” and “No” options. 

10.  Press the Up/Down button to select Yes to delete or No to exit. 
11.  If Yes, press the OK button to confirm, save and delete all the 
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unprotected images. 
 
 

Slide Show 
You can have all the photos appear one after the other as a Slide 
Show.  
 

1. Press the MENU button. 
2. Press the Up/Down button to select the Slide Show menu. 
3. Press the OK button to open the Slide Show submenu. 
4. Press the Up/Down button to highlight and select one of the Slide 

Show options: 
   

                            Start; Interval; Repeat 

5. If you select Start the Slide Show will begin to play. 
6. Press the Up button to pause or again to continue. 
7. Press the OK button to exit the Slide Show 

 
8. If you select Interval, press the Left/Right button to increase or 

decrease the interval between images when playing the Slide Show 
by 1 to 10 seconds. 

9. Press the OK button to save the time interval and exit. 
 

10. Press the Down button to select to the Repeat option. 
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11. Press the Left/Right button to toggle between the Yes and No 
options if you wish the Slide Show to automatically repeat itself or not. 

12. Press the OK button to save your choice and exit the Slide Show 
submenu. 
 
Note: On selecting the Start option again in the Slide Show submenu 
the Slide Show will now play according to the new settings selected. 
 

            Effect 
  This setting is used to change the image’s color tone. 
 

1. Press the Up/Down button to select the Effect menu. 
2. Press the OK button to open the Effect submenu. 
3. Press the Up/Down button to highlight and select the Effect option you 

wish to use: 
 
Normal / B&W / Sepia / Negative / Red 
 

4. Press the OK button. 
5. A “Waiting…” message appears while the new Effect is saved. 
6. The new Effect now appears on the selected image in the Playback 

mode. 
 
 

             Rotate  
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  You can rotate photos on the camcorder 
 

1. Press the Up/Down button to select the Rotate menu. 
2. Press the OK button to open the Rotate submenu. 
3. Press the Up/Down button to highlight and select the Rotate options: 

 
Rotate; Save; Back 
 

4. To rotate the selected image, select the Rotate option. 
5. Press the OK button to begin rotating the image each time 90 degrees 

to the right (clockwise). 
6. Press the Up/Down button to select the Back option to undo the last 

rotate before it is saved. 
7. Once you have rotated the image to your liking, press the Up/Down 

button to select the Save option. 
8. A “Waiting…” message appears while the rotated image is saved. 

 
 

           Resize  
  You can resize a photo on the camcorder 
 

1. Press the Up/Down button to select the Resize menu. 
2. Press the OK button to open the Resize submenu. 
3. Press the Up/Down button to highlight and select the Resize options: 
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2048x1536; 1024x768, 640x480 
4. You will only be able to resize down the resolution of the original photo. 

Note: If the original photo was captured in 8M and 5M then it can be 
resized to any of the above 3 options. A 3M photo can be resized to the 
last 2 options and a 1M photo to the last option. Photos captured in 
VGA cannot be resized. 
 

5. Press the OK button. 
6. A “Waiting…” message appears while the image is saved and resized 

to the resolution you selected. 
. 

           Voice Memo  
  You can add a voice memo message to a photo on the camcorder 
 

1. Press the Up/Down button to select the Voice Memo menu. 
2. Press the OK button to open the Voice Memo submenu. 
3. Press the Up/Down button to highlight and select the Voice Memo 

options: 
 
Add; Delete 
 
 
 

4. If you wish to add a voice memo select the Add option and press the 
OK button. 
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5. The elapsed time for the voice memo appears in the center of the LCD. 
6. Press the Shutter button to stop and save the Voice Memo to the photo. 

7. The photo with voice memo will now have a white audio icon  on the 
middle left side of the LCD. 

8. To play the voice memo in a photo press the Shutter button. The voice 
memo will begin to play.  

9. Use the MENU button to Stop the voice memo; The Left button to 
Rewind; The Up button the pause the voice memo;  and the Right 
button to Fast Forward. 

 
10. If you wish to delete a voice memo from a photo, select the Delete 

option.  
 

11. Press the OK button. The voice memo and corresponding icon is 

removed from the selected photo. 

 

       Start-up Image  
 You can select a photo on the camcorder to appear as the image that 

appears on the LCD when powering on the camcorder 
 

1. Select a photo that you wish to appear every time you power on the 
camcorder. 

2. Press the Up/Down button to select the Start-up Image menu. 
3. Press the OK button to open the Start-up Image submenu. 
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4. Press the Up/Down button to highlight and select the Start-up Image 
options: 
 
Set; Cancel 
 

5. If you wish to set the selected image select the Set option and press the 
OK button. 
 

Note: In order for this image to appear, the Start-up Image in the Setup 
mode needs to be set to “My image” (see the Setup section for more details) 
 
 
 

     Operation for AVI video files 
You can playback AVI files (with audio) recorded on your camcorder or view 
them on your TV when the camcorder is connect to the TV with the TV-out 
cable provided. 
  
1. Use the Left/Right button to select an AVI file you wish to play. 
2. A red video icon will appear on the bottom left corner of the LCD to 

indicate that the image you selected in a video. 
3. Press the Shutter button to start playing the video. 
4. Press the Up button to Pause the video and again to continue playing. 
5. Press the MENU button to stop the playback. 
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6. Press the Left button to Fast Rewind and the Up button to pause and 
play. 

7. Press the Right button to Fast Forward and the Up button to pause 
and play. 

 
There are 2 setting for the Video playback mode - Lock and Delete 
 

                Lock 
You can lock and protect your photos, videos or audio files from 
accidental deletion.  
 

1. Press the MENU button. 
2. Press the Up/Down button to select the Lock menu. 
3. Press the OK button to open the Lock submenu. 
4. Press the Up/Down button to highlight and select one of the lock 

options: 
 

                Lock/Unlock One; Lock All; Unlock All  

5.   If you selected Lock/Unlock One and press the OK button a “Protect 
Image?” or “Unprotect Image” confirmation message will appear with 
“Yes” and “No” options. 

6.  Press the Up/Down button to select Yes to lock/unlock or No to exit. 
7.  Press the OK button to confirm, save and protect/unprotect the 

selected image. 
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8.  If you selected Lock All and press the OK button a “Protect All?” 

confirmation message will appear with “Yes” and “No” options. 
9.  Press the Up/Down button to select Yes to lock or No to exit. 
10.  Press the OK button to confirm, save and protect all the images. 

 
11.  If you selected Unlock All and press the OK button an “Unprotect All?” 

confirmation message will appear with “Yes” and “No” options. 
12.  Press the Up/Down button to select Yes to unlock or No to exit. 
13.  Press the OK button to confirm, save and unprotect all the previously 

protected images. 
 

Note: 

After selecting your lock preference, the corresponding lock  icon will 
appear on the left hand side of the LCD for the image(s) selected.  

            
                     

             Delete 
You can delete unwanted photos, videos and audio files at any time 
to free up memory. You can delete one at a time or delete all the 
unprotected files that are currently recorded on the memory card at 
once. 
 

1. Press the MENU button. 
2. Press the Up/Down button to select the Delete menu. 
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3. Press the OK button to open the Delete submenu. 
4. Press the Up/Down button to highlight and select one of the delete 

options: 
 

                One; All  

5.  If you selected One and press the OK button a “Delete This File?” 
confirmation message will appear with “Yes” and “No” options. 

6.  Press the Up/Down button to select Yes to delete or No to exit. 
7.  If Yes, press the OK button to confirm, save and delete the selected 

image. 
8.  If the selected file is locked a “File locked!” message will appear. To 

unlock the file follow Steps 1 to 6 in the Lock section above.  
 

9.  If you selected All and press the OK button a “Delete All?” confirmation 
message will appear with “Yes” and “No” options. 

10.  Press the Up/Down button to select Yes to delete or No to exit. 
11.  If Yes, press the OK button to confirm, save and delete all the 

unprotected images. 
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   Setup Mode 

The Setup mode can be accessed from the Video, Camera Capture and 
Playback modes. 
 
In Setup mode you can set - Sounds, Auto Review, Power Frequency, 
Power Save, Date & Time, Language, TV Out, USB, Start-up Image, 
Format and Reset All. 
 
1. Press the MENU button. 

2. Press the Right button to select the   icon to open the Setup menu. 
 
 

 

 

 

 

 

 

 
      Sounds 
 In this Setup mode you can adjust the sounds the camcorder emits 
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1. Press the Up/Down button to select the Sounds menu. 
2. Press the OK button to open the Sounds submenu. 
3. Press the Up/Down button to highlight and select the Sounds options:  

 
Shutter; Start-up; Beep; Volume 
 

4. To turn on or off the sound the Shutter makes when pressed, use the 
Right/Left button to select On or Off. 

5. Press the OK button to save your choice. 
 

6. The set the Start-up sound, press the Left/Right button to select – 
None, 1, 2 or 3. Each number has a different sound that sounds when 
selected. 

7. Press the OK button to save your choice. 
 

8. To turn on or off the sound the Beep makes, use the Right/Left button 
to select On or Off. 

9. Press the OK button to save your choice. 
 
 

10. To adjust the sound Volume for buttons that emit sounds when 
pressed, use the Right/Left button to select 0, 1, 2 or 3. 

11. Press the OK button to save your choice. 
12. Press the MENU button to close the menu and exit the Setup function. 
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      Auto Review 
 In this Setup mode you can adjust the review time after taking a picture 

 
1. Press the Up/Down button to select the Auto Review menu. 
2. Press the OK button to open the Auto Review submenu. 
3. Press the Up/Down button to highlight and select the Auto Review 

options:  
 
   Off; 1 sec; 3 sec 
 

4. Press the OK button to save the Auto Review option that you selected. 
5. Press the MENU button to close the menu and exit the Setup function. 

 
 

      Power Frequency 
 In this Setup mode you can adjust the light frequency depending on the 
region you are located. Generally, 60HZ is for the U.S. and Canada, 50HZ for 
Europe and Japan. 

 
1. Press the Up/Down button to select the Power Frequency menu. 
2. Press the OK button to open the Power Frequency submenu. 
3. Press the Up/Down button to highlight and select the Power 

Frequency options:  
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50Hz; 60Hz 
 

4. Press the OK button to save the Power Frequency option that you 
selected. 

5. Press the MENU button to close the menu and exit the Setup function. 
 
 

      Power Save 
 In this Setup mode you can save battery power by selecting the time before 
the camcorder will automatically power off if the camcorder is left on and not 
in use  

 
1. Press the Up/Down button to select the Power Save menu. 
2. Press the OK button to open the Power Save submenu. 
3. Press the Up/Down button to highlight and select the Power Save 

options:  
 
1 min; 3 min; 5 min 
 

4. Press the OK button to save the Power Save option that you selected. 
5. Press the MENU button to close the menu and exit the Setup function. 

 
 

      Date & Time 
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          Set the date and time that will appear on the photos you capture. 
 

1. Press the Up/Down button and select the Date & Time option. 

2. Press the OK button to open the Date & Time settings. 

3. Press the Left/Right button to select the options: 
 
 Year, Month, Day, Hour, Minute and Date Format (YYYY/MM/DD , 
DD/MM/YYYY , MM/DD/YYYY)  
 
 
 
 
 
 
 
 

4. Press the Up/Down button to change the digits on each of the settings you 
wish to update. 

5. Press the OK button to save your choice.  

6. Press the MENU button to close the menu and exit the Setup function. 
 
 

  Language 
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When using the video camcorder for the first time after purchasing it, be sure to 
choose a language before using the video camcorder. 
 

1.   Press the Up/Down button and select the Language option. 
2.   Press the Right button to enter the Language submenu. 
3.   Press the Up/Down button to highlight and select the language you desire. 

 
    English; French; German; Italian; Spanish; Portuguese or Dutch 

4.   Press the OK button to save your choice and for the language interface of 
the camcorder to change to the language you selected.  

5.   Press the MENU button to close the menu and exit the Setup function. 
 

 

TV-Out 

The image of the picture you wish to capture on the LCD can also be displayed on 
your TV screen instead when using the TV cable provided. 
Before using this feature you need to know what the TV setting is for viewing in your 
region. The incorrect setting will cause images to not appear correctly. 
 

1.   Press the Up/Down button and select the TV-Out option from the menu. 
2.   Press the Right button to enter the TV-Out submenu. 
3.   Press the Up/Down button to highlight and select the TV-Out option you 

desire: 
                   NTSC ; PAL 
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4.   Press the OK button to save your choice.  
5.   Press the MENU button to close the menu and exit the Setup function. 

 
 

USB 

Your camcorder can be used as either a MSDC (Mass Storage device) or PC 
Camera. Use this mode to select the USB option that will appear as default 
every time you connect your camcorder to the PC using the USB cable. 

 
1.   Press the Up/Down button and select the USB option from the menu. 
2.   Press the Right button to enter the USB submenu. 
3.   Press the Up/Down button to highlight and select the USB option you 

desire. 
 

MSDC; PCCAM 
 

4.   Press the OK button to save your choice. 
5.   Press the MENU button to close the menu and exit the Setup function. 

 
 

Start-up Image 

You can select the picture that you like best on your camcorder to appear each 
time you power on your camcorder. 
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1.   Press the Up/Down button and select the Start-up Image option from the 
menu. 

2.   Press the Right button to enter the Start-up Image submenu. 
3.   Press the Up/Down button to highlight and select the Start-up Image option 

you desire. 
 

Off; System; My Image 
 

4.   If you select the Off option, no picture will appear on power on. 
5.   If you select the System option, the Vivitar system graphic will appear on 

power on. 
6.   If you select the My Image option, the photo that you selected in the Startup 

image section of the Playback mode will appear on power on. 
7.   Press the OK button to save your choice. 
8.   Press the MENU button to close the menu and exit the Setup function. 

 
 

Format 

Using this function will delete all the files (including protected ones) in internal 
memory or the SD memory card. 
Caution: Please make sure to download the images first before using this 
feature as all the images sitting in the camcorder will be erased from the card 
and internal memory. This process is irreversible. 

 
1.   Press the Up/Down button and select the Format option from the menu. 
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2.   Press the OK button to enter the Format submenu. 
3.   Press the Up/Down button to highlight and select the Format option you 

desire. 
Yes; No 
 

4.   If you wish to format the memory select Yes or No to cancel the format. 
5.   Press the OK button to begin the Format. 
6.   A “Waiting…” message appears on the LCD as the camcorder is formatted. 

 
Reset All 

Using this function will reset the camcorder to the original factory settings. 
 

1.   Press the Up/Down button and select the Reset All option from the menu. 
2.   Press the OK button to enter the Reset All submenu. 
3.   Press the Up/Down button to highlight and select the Reset All option you 

desire. 
Yes; No 
 

4.   If you wish to reset the camcorder select Yes or No to cancel the reset. 
5.   Press the OK button to reset. 
6.   Press the MENU button to close the menu and exit the Setup function. 
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 Connecting the Camcorder to a TV 
Connect the video camcorder to the TV via the supplied cable. Power on the TV 
and the video camcorder. The video camcorder’s LCD screen turns blank, and 
picture that previously appeared on the camcorder`s LCD screen now appear on 
the TV screen. 
 
1. Connect the video camcorder to a TV via the TV-out cable (supplied). The TV 

slot is situated next to the USB slot at the back of the camcorder. Lift up the 
cover and insert the cable. 

2. Turn on the TV and the video camcorder, and then set the TV to “AV” mode.  
3. When the video camcorder is set to record, capture or playback mode, you 

can preview the subjects you want to record on the TV screen.  
4. When the video camcorder is set to Playback mode, you can review all the 

pictures, video and audio clips stored in the video camcorder on the TV. 
 

 

Install the Vivitar Experience Image Manager Software  
Warning: Do not plug your camcorder into the computer until the software 
installation is complete 
You must be connected to the internet to install and run the Vivitar Experience 
Image Manager software. 
 

1. Insert the installation CD into your CD-ROM drive. The installation screen 
should automatically open.  
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2. On PC: The Vivitar Experience Image Manager Installer window appears. If 
the window does not appear, open the application’s CD/DVD drive and click 
on “Setup.bat” to launch the installer. 

3. On Macintosh: Click the icon to install the Vivitar Experience Image Manager. 
4. If you do not have internet access at the time of inserting the CD-ROM, 

connect to the internet and then click the “Install Vivitar Experience Image 
Manager” button to begin the installation 
Note: If you do not have internet access, you can still download media from 
the camcorder. Click the “How to transfer photos and videos from my 
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camcorder to my computer” button for instructions. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5. If you have internet access, the “Choose your language” window opens, 
choose your language and click “Next” to open the next window. 

6. Select your camcorder model from the list and click “Next” to open the next 
window. 

7. Click “Next” to confirm your camcorder model selection and to install the 
application. 

8. Please wait while the application is being installed on your computer.                     
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9. Please review the license terms. 
On PC: Click the “I Agree” button to continue. 
On Macintosh: Click the “I accept the terms of this license agreement” and 
then click “Next” to continue. 

10. On PC only: Let the “Vivitar Experience Image Manager” installer create the 
folder to where the program will be installed, and then click “Install”.  

11. Please wait while the application continues the installation process on your 
computer. 

12. On PC: Click the “Close” button when the installation is complete. 
 
Note: If your camcorder is also a PC camera, the PC camera driver will be 
included in the installation process. Follow the instructions to install the driver. 
 
On Macintosh: Click the “Quit” button when the installation is complete. 

13. Click the “Launch Vivitar Experience Image Manager” to open the application 
or close the window and run the Vivitar Experience Image Manager from your 
computer. 

 
 
 
 
 
. 
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Connect your camcorder to the computer 
1. Use the USB cable that came with your camcorder to connect your 

camcorder to your computer. 
2. Turn the camcorder on. 
3. The first time you connect the device to the computer you will have to wait a 

few seconds until the computer recognizes the device. 
4. As your camcorder is a mass storage device “MSDC” will appear on the LCD, 

indicating that your camcorder is in Mass Storage Mode.  
5. If your camcorder appears in PC Camera mode, press the DV/DSC button on 

the bottom left of the LCD screen to change it back to Mass Storage mode. 
6. To use your camcorder as a PC camera, press the DV/DSC button on the 

bottom left of the LCD screen to change it back to PC Camera mode. 
 
 

Get photos and videos from your camcorder to your 
computer 

An SD card needs to be inserted. Do not disconnect the cable during transfer. 
Doing so will cancel the transfer of any files on their way to your computer. 
 

1. Select the “Get Images” button from the Main menu. 
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  65 

2. The “Get media from device” window opens. 
3. You can select to download photos, videos or both. 
4. Select your camcorder (removable disk) from the device window. If your 

camcorder is the only USB device connected then it will be selected 
automatically. 

5. Select a location on the computer where to place the new photo and video 
files. 

6. Add the new photo and video files to albums if desired. 
7. Select to remove the media files from the selected device (removable disk) 

after the import. 
8. Click the “Get media” button to transfer the photos and videos from your 

camcorder to your computer. 
A media download progress bar appears on the bottom left showing the 
number of media files downloading to your computer. A message appears 
when the download is complete. 

9. The photo and video files that you selected are now downloaded to your 
computer to the selected folder and albums ready for your use.       

Get started! 
Using the Vivitar Experience Image Manager, you can upload and manage photos 
and videos to and from the most popular photo sharing and social networking sites 
- Facebook, Flickr, MySpace, Picasa, Photobucket and YouTube. Seamlessly 
transfer photos and videos from one social network to another. Organize your 
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images by creating offline and online albums. Edit images using automatic and 
manual tools. Use automatic “Geotagging” with built in Google Maps. 

 
For more details on how to use the Vivitar Experience Image Manager open 
the Help file or click the “Take the Tour” button on the application`s Home 
page. 

 

Transfer media from my camcorder to my computer manually 
(Using Windows) 

1. Use the USB cable that came with your camcorder to connect your 
camcorder to your computer. 

2. “MSDC” will appear on the LCD, indicating that your camcorder is in Mass 
Storage Mode.  

3. If your camcorder appears in PC Camera mode, press the DV/DSC button on 
the bottom left of the LCD screen to change it back to Mass Storage mode 

4. A window appears with a list of options, select Open folder to view files and 
click OK. 

5. Open the DCIM folder and the folder inside to view the media files. 
6. Select the media and copy the files from this folder into your computer. 

Optionally, select the files and choose Copy from the Edit menu. Then select 
a folder and choose Paste from the Edit menu.  

7. We recommend that you copy the images into the Pictures/My Pictures folder 
and the videos into the Videos/My Videos folder. 

8. Do not disconnect the cable during transfer. Doing so will cancel the transfer 
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of any files on their way to your computer. 

 
Transfer media from my camcorder to my computer manually 
(Using Macintosh) 

1. Use the USB cable that came with your camcorder to connect your 
camcorder to your computer.  

2. “MSDC” will appear on the LCD, indicating that your camcorder is in Mass 
Storage Mode.  

3. If your camcorder appears in PC Camera mode, press the DV/DSC button on 
the bottom left of the LCD screen to change it back to Mass Storage mode 

4. The camcorder’s device icon appears on the desktop. 
5. Click on the device icon and open the DCIM folder and the folder inside to 

view the media files. 
6. Select the files and drag them into your computer. Optionally, select the files 

and choose Copy from the Finder’s Edit menu. Then select a folder and 
choose Paste from the Edit menu. 

7. We recommend that you copy the images into the Pictures folder and the 
videos into the Movies folder. 

8. Do not disconnect the cable during transfer. Doing so will cancel the transfer 
of any files on their way to your computer. 

 
 Note: After you connect your camcorder to your PC, the camcorder will remain on all 
the while it is plugged into the USB and it won’t be switched off. On disconnecting the 
USB cable the camcorder will automatically switch off. 
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Using your camcorder as a PC Camera (on Windows) 
    You can use your camcorder as a PC Camera for Web Conferencing and Instant 

Messaging.  

 

1. Plug the camcorder into an available USB port on your computer. 

2. Turn the camcorder on. 

3. Make sure the camcorder is in PC Camera mode. To change to PC Cam 

mode if the MSDC mode appears, press the DV/DSC button on the bottom 

left of the LCD screen. 

4. Wait for the computer to recognize the new hardware if this is the first time 

you are using it in PC Camera mode. 

 

 

 

 

 

 

5. Once the computer recognizes the camcorder driver you can open the Web 

Conferencing or Instant Messaging application you use and activate the 

Webcam function. 
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Sakar Warranty Card 
This warranty covers for the original consumer purchaser only and is not transferable. 
Products that fail to function properly UNDER NORMAL USAGE, due to defects in 
material or workmanship. Your product will be repaired at no charge for parts or labor 
for a period of one year. 
 
What Is Not Covered By Warranty: 
Damages or malfunctions not resulting from defects in material or workmanship and 
damages or malfunctions from other than normal use, including but limited to, repair 
by unauthorized parties, tampering, modification or accident. 
 
What To Do When Service Is Required: 
When returning your defective product (postage pre-paid) for service, your package 
should include: 
1. Copy of original bill of sale 
2. A detailed written description of the problem. 
3. Your return address and telephone number (Daytime) 
 
 
MAIL TO ADDRESS BELOW: 
Sakar International 
Attention: Service Department 
195 Carter Drive 
Edison, NJ 08817 
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TECHNICAL SUPPORT: 

For technical support issues please visit our website at www.vivitar.com. You can find 

manuals, software and FAQ’s at the website. Can’t find what you are looking for? E-mail 

us at support@vivitar.com and one of our technical support team members will answer 

your questions. For phone support in the US please call 1-800-592-9541, in the UK call 

0800 917 4831.  If you would like to call from anywhere else, please visit 

www.vivitar.com for your local toll free number.  
 

 

Technical Specifications 

 
Image 
Resolution 

8M(3264X2448); 5M(2592X1944); 3M(2048X1536); 
1M(1024X768); VGA(640X480) 

Video 
Resolution 

VGA:  640*480  (15 / 30fps); 
QVGA: 320*240  (15 / 30fps ) 

LCD Display 1.96” TFT(4:3) 

Focus range 150cm ~ infinity 

Shutter  Electronic Shutter: 1/6,000 ~ 1/20sec. 

Internal Memory Limited 

External SD card up to 8 GB 

http://www.vivitar.com/
mailto:support@vivitar.com
http://www.vivitar.com/
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Memory 

Sensitivity Auto  

Lens F=3.2 Fixed Focus 

Digital Zoom 8x 

Self-timer 2s/10s 

File Format JPEG ( Still Image) /AVI ( Video) / WAV (Audio) 

White balance Auto / Daylight / Tungsten / Fluorescent / Cloudy 

Exposure 
control 

-2EV to +2EV in 0.3 counts 

Photo effect Color/Sepia/Monochrome 

Language English, French, German, Italian, Spanish, Portuguese and 
Dutch 

Burst Included 

TV out NTSC / PAL 

Microphone YES 

Speaker YES 

Recorder YES 

Interface USB 2.0 

System 
Requirements 

Windows XP, VISTA or MAC OS X 10.4.6 and higher  

Battery 3*AAA (1.5V alkaline) 

Working 
Temperature 

0 - 40° C 
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Trouble Shooting 
Power does not turn on. 

1. The Battery is inserted in the 
wrong direction. 

★Reload battery in the correct 

direction. 
2. The Battery has insufficient 
power to power on. 

★Replace or recharge the 

battery. 
The camcorder does not take pictures. 
1. The Memory is full. ★Insert a new memory card. 

2. The Memory card is not 
formatted correctly. 

★Format the memory card again 

or use a new card. 
Image is blurry or out of focus. 
1. The video camcorder was 
moving when the image was 
captured. 

★Hold the video camcorder 

steady when shooting picture. 

Image is not displayed on the LCD monitor. 
1. A memory card with non-PICT 
images (recorded with other 
camera) is loaded. 

★This video camcorder cannot 

display non-PICT images. 

Recorded images are not saved in memory. 
1. The video camcorder was 

turned off before the images 
are saved in memory. 

★If the battery low indicator 

appears on the LCD monitor, 
replace the battery immediately. 
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